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3. Imported Graphics Issues 

 3.1 - General Graphics Handling Recommendations (1 message; 2/15/05) 
 3.2 - EPS: Looks and/or prints rough or "pixely" (1 message; 1/18/05) 
 3.3 - EPS: White background (1 message; 5/3/02) 
 3.4 - TIF: Looks and/or prints blurry or "low-res" (1 message; 10/30/02) 
 3.5 - TIF: Looks darker and/or color shift (1 message; 1/18/05) 
 3.6 - TIF: Maintaining transparency from Photoshop to PageMaker (1 message; 1/18/05) 
 3.7 - JPEG: Why you shouldn't use them in PageMaker (1 message; 1/18/05) 
 3.8 - JPEG, GIF, WMF, BMP, etc - any problems (1 message; 1/18/05) 
 3.9 - AutoCAD drawings (1 message; 2/26/03) 
 3.10 - Duotones & Multi-Channel Images (1 message; 11/18/02) 
 3.11 - Importing Adobe Illustrator Files (*.AI) and how they differ from *.EPS (1 message; 4/8/04) 
 3.12 - Picture Palette Error: "The image cannot be found. Please enter …" (1 message; 1/18/05) 
 3.13 - What is the difference between RGB and CMYK? (1 message; 7/29/04) 
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Topic 

3.1 - General Graphics Handling Recommendations

Donald Gruener - 09:07am May 3, 2002 Pacific

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 8:11am May 17, 02 PST (#1 of 1) Edited: 15-Feb-2005 at 11:02am 

●     ONLY use File>Place to bring graphics into PageMaker

When placing images in a PageMaker file, the following message appears:
“The graphic in the linked file would occupy xxxxxxx bytes in the publication. Include the complete 
copy in the publication anyway?”
The correct answer to this question is always "NO". 

(You can permanently avoid this popup in future docs by unchecking "store copy in publication" under 
Element -> Link Options with no publication open. You can do the same to avoid further prompts in pre-
existing documents.) 

●     Do NOT use Insert Object or Paste Special

Object Linking and Embedding is highly problematic in the Postscript environment (e.g. creating 
PDFs), severely restricts portability (other applications have to be present) and is really only present in 
PageMaker to gain Microsoft approval as a Windows application. It has been dispensed with in newer 
applications, e.g. InDesign. 

●     Do not Place graphics from a floppy, Zip disk, CD, or network drive. Copy the graphic file to your local hard 
drive, then Place.
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●     Use only TIF or EPS graphics (plus PSD and AI with PM7)

●     Do NOT use JPEG, GIF, WMF, CGM, DXF, or any graphics format other than TIF or EPS
   (Click here for the Adobe Knowledgebase article about the Limitations of Metafiles.)

●     You can place PDFs as graphics - they are essentially handled as EPS by PageMaker

●     Do NOT copy/paste graphics from other applications. The Windows clipboard will lose information required 
by PageMaker for high quality output. 

●     Do not embed your graphics in PageMaker documents. Link only. (See the first bullet point)

●     Save Illustrator or CorelDraw graphics as EPS for placing in PageMaker

●     For best results with Illustrator EPS, convert all type to outlines, and save back to version 7.

●     Save Photoshop graphics as TIF (the exception is duotones - save as EPS)

●     Size your Photoshop graphics in Photoshop - do not scale in PageMaker, or if you must, do NOT scale UP 
(e.g. stretch a TIF to make it larger) in PageMaker.

●     Photoshop's preferences should be set to NOT embed profiles in grayscale images - they can cause 
problems in PageMaker

●     PageMaker supports transparency in vector EPS or TIFs with clipping paths ONLY. GIFs will not retain 
transparency and shouldn't be used in PageMaker anyway. See the other FAQs in section 3 for more details 
on transparency.

●     PageMaker does not support progressive JPGs nor 16bits/channels TIFFs. Use Photoshop and re-save as 
8bits/channel TIFFs.

See also this page in the Adobe PageMaker Support Knowledgebase: 
Recommended Workflow for Creating PageMaker Publications. 
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Topic 

3.2 - EPS: Looks and/or prints rough or "pixely"

Donald Gruener - 10:47am Jan 19, 2002 Pacific

Issue: Your EPS graphics look and/or print terrible when you place them in a PageMaker document. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 10:53am Jan 19, 02 PST (#1 of 1) Edited: 18-Jan-2005 at 03:16pm 

Screen Display 
Typically, EPS files carry a low resolution TIF header which provides an on-screen preview when placed in 
PageMaker. Remember that what you are seeing is essentially a placeholder that represents the EPS. 
Regardless of on-screen appearance, your EPS will output perfectly to a PostScript laser printer, or to 
whatever output device your commercial printer or service bureau will be using. 

While this rough, pixelated image may seem disconcerting at first, I assure you that with time you do get 
used to using them. To assist in precision placement, use guides with "snap to guides" turned on. 

That said, you can force PageMaker to create its own higher-resolution EPS preview. Check the "Show Filter 
Preferences" checkbox in the Place dialog. This will bring up a new dialog in which you can specify the 
resolution of the preview up to 300 dpi. I find that as low as 150 dpi is adequate to provide a decent on-
screen preview. Bear in mind that you are generating additional image data that your PageMaker file has to 
carry. Doing this excessively can lead to a bloating file. 

If you are creating your EPS graphics in CorelDraw, then you can choose to save your EPS with a WMF 
preview, which will display nicely in PageMaker. Or, using Illustrator, you can save your graphic both as an 
EPS and a WMF, then use a free program called EPSWMF, available at Steve Rindsberg's site, to "marry" 
the EPS and the WMF. Click Here for Steve's EPSWMF utility 

Printing 
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As stated above, regardless of how it looks on screen, if you are printing to a PostScript printer, your EPS will 
output just fine. If you do not have a PostScript printer, here are some workarounds to get a decent printout: 

●     Forcing PageMaker to create a preview at 300 dpi (as detailed above) will give you reasonable output on 
an office laser. Again, watch for file bloat.

●     A better solution for printing documents containing EPS to non-PostScript printers is to simply create a 
PDF of the document and print that instead. 

●     A third workaround: if your final destination is a non-PostScript device and your document will not be going 
to a service bureau or commercial printer for high-end output, you can export your graphic as a 300 dpi TIF 
from Illustrator. This will look fine on screen in PM and print fine to non-PS printers. Bear in mind that the 
graphic will be rasterized so do not try to scale it up in PM. 
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Topic 

3.3 - EPS: White background

Donald Gruener - 10:56am Jan 19, 2002 Pacific

Issue: You place what you thought was a transparent vector EPS in PageMaker, but there is a white 
background. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 10:58am Jan 19, 02 PST (#1 of 1) Edited: 25-Jan-2002 at 04:47pm PST 

This is simply because you are seeing a preview of the EPS. It WILL output correctly to a PostScript device, 
with no white background. However, if the white background bugs you, simply rotate the EPS .01° and the 
white will disappear. This miniscule amount of rotation will not be discernable upon final output. 

The only problem with this little trick is that if you have areas filled with white in your EPS - in other words, 
white areas that should NOT be transparent - that white will also disappear on screen when you rotate the 
EPS. However, if your EPS is actually set up with a white-filled object, it will print properly to a PostScript 
device, with white areas white and transparent areas transparent. 

NOTE: You can try rotating the EPS back to 0° - for some people the white background will remain invisible, 
for others (myself included) the white background reappears. 

CAUTION: Do not attempt to use this trick with a Photoshop EPS. Photoshop EPS are raster images and 
white backgrounds will always be white unless you have used a clipping path. If you rotate a Photoshop EPS 
in PageMaker, the white background will disappear on screen but this is an illusion. The background will be 
there at output. 
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Topic 

3.4 - TIF: Looks and/or prints blurry or "low-res"

Donald Gruener - 10:38am Jan 19, 2002 Pacific

Issue: Your TIF looked and printed great from Photoshop, but looks and/or prints blurry when Placed in a 
PageMaker document. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 10:44am Jan 19, 02 PST (#1 of 1) Edited: 30-Oct-2002 at 01:54pm PST 

Screen Display 
By default, PageMaker will just show you a low resolution preview of your TIF file. Regardless of the messy 
on-screen appearance, it will output just fine. If you need to see it more clearly, go to File>Preferences and 
set Graphics Display to High Resolution. Bear in mind working in this mode can bog your machine down 
some. (This is most noticeable in large documents containing many CMYK images, but is otherwise not 
really an issue anymore) 

To assist with precision placement when working with lo-res previews, don't forget you can pull guides and 
turn on the Snap To Guides option which will provide nice precise placement without seeing the image 
clearly or having to zoom in. 

Printing 
In PageMaker's print dialog, click on the Options button and set the "Send Tif/Images" option to Normal and 
NOT to Optimized. The deceptively-named optimized option actually downsamples your image for faster 
draft printing and can significantly reduce the printed quality of your placed image. 

This can affect PDF creation too, since you essentially "print" a PostScript file which is then distilled to PDF, 
so make sure you've set that option to Normal. If you have and your PDF images still look bad, you probably 
need to check your downsampling and compression settings in Distiller's Job Options. (See the PDF Section 
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Topic 

3.5 - TIF: Looks darker and/or color shift

Donald Gruener - 12:24pm Jan 21, 2002 Pacific

Issue: Your images looked good in Photoshop, but when you placed the TIFs in PageMaker, they look dark, 
muddy, possibly reddish. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 12:38pm Jan 21, 02 PST (#1 of 1) Edited: 18-Jan-2005 at 03:18pm 

Details about colour management in PM 
Thanks to Peter Linnell 

You have to understand that - on screen - your image will never look EXACTLY as it did in Photoshop. 
Photoshop and PageMaker use different colour management systems - with different algorithms. 

●     Photoshop = Adobe CMS 
●     PageMaker = Kodak CMS (on Windows - all versions) which is older and transforms colours in different 
way than Adobe CMS. 

When it comes to colour management on PM: 

1) An accurate monitor profile is essential. Adobe Gamma with a lot of messing around, can get you 
somewhere close. Hardware profiling is miles more accurate. I like the monitor profiler from http://www.
littlecms.com - more complex, but closer to a hardware created profile. The Delta e, which is the 
measurement of accuracy is quite good with littlecms. 

2) Your destination profile is next in importance in obtaining an accurate proof which will resemble the final 
print. Your CMYK output selection in Photoshop should match exactly the same one selected in PM. Without 
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this all bets are off. 

3) IF, and this is always the big if, you have Photoshop setup correctly - including the proof preview settings 
dialled in - trust Photoshop. 

You can get reasonable good colour managed previews in PM, if you have everything in your workflow set 
up properly. 

It is beyond the space here to elaborate everything needed to get CMS working right on PageMaker, but the 
defaults do not work right sometimes and one must know exactly how to work with the profile settings. 

My test for CMS on PM - take file - distill a hi res PDF in Acro 4 or 5 with colour management "unchanged" 
and then open this in Acrobat - print to a colour PS printer. If it looks ugly, you probably have some settings 
wrong in PM or PS. 

A Starting Point 

You need to use PageMaker's colour management system. Here are the settings provided to me by Len 
Hewitt which I have been using with success: 

Colour Management: ON 

Monitor Simulates: Composite Printer 

New Items Use: Kodak ICC 

Kodak ICC Settings: 

Monitor: Select the monitor profile you created with Adobe Gamma from Photoshop 

Composite Printer: Select the ICC Profile for your desktop printer (if applicable) 

Separations Printer: Select the same profile as your Photoshop CMYK setup (SWOP Coated for instance) 

RGB Image Source: Same as your Photoshop RGB working space (AdobeRGB for instance) 

CMYK Image Source: The same as your Photoshop CMYK setup. 

CMYK Images from Photoshop will then appear pretty similar in PageMaker to Photoshop. It doesn’t matter 
whether you embed profiles when saving from Photoshop as you are telling PageMaker what profiles to 
assume. 

Do NOT embed ICC profiles in greyscale images from Photoshop - this confuses PageMaker’s colour 
management system and can lead to all kinds of problems. 

Special thanks to Len Hewitt for providing these settings. Click here for more of Len's tips. 

Additional note: PageMaker 6.5 AND 7.0 on Win2k and XP will look for colour profiles in Winnt\system32
\color\ whereas the default for Win2k\XP is winnt\system32\spool\drivers\color. Pagemaker will not see those 
Photoshop 6 profiles without manually copying them from the latter to the former. 

For more colour management help, you might want to check out the Colour Management forum.
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Topic 

3.6 - TIF: Maintaining transparency from Photoshop to PageMaker

Donald Gruener - 09:09am Jan 23, 2002 Pacific

Issue: You want to bring in a TIF from Photoshop with no background. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 9:18am Jan 23, 02 PST (#1 of 1) Edited: 18-Jan-2005 at 03:20pm 

You must create a clipping path in Photoshop prior to bringing your image into PageMaker. (Briefly: in 
Photoshop, use the Pen tool to create a path around what you want to keep. Save the path. Then select the 
saved path as your clipping path. For more details see the link to Len's article below). 

You can also use clipping paths with Photoshop EPS, but normally the only reason you'd be saving as EPS 
from Photoshop is if your image is a duotone or contains a spot channel. 

Bear in mind that clipping paths are hard-edged and you won’t be able to have soft effects like drop shadows 
and outer glows appear transparent over PageMaker objects. To have these sorts of effects, you will need to 
build everything in Photoshop, including the background elements you normally would have created in 
PageMaker, and bring the whole thing into PM as a single graphic. 

For soft, transparent drop shadows in documents that will be printing in at least two colors including black, 
you can also try the technique Len Hewitt explains in his excellent article on clipping paths (it's on page 7 of 
the article). 

Click Here for Len Hewitt's Clipping Paths Article (PDF - 314Kb) 

Similar descriptions of how to create clipping paths in Photoshop® are at:
Using Clipping Paths In Photoshop® and 
Removing the Background in Photoshop® 
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Adobe is not responsible for the content of external internet sites 

See also this page in the PageMaker Support Knowledgebase which is covers versions of PM prior to PM7. 
Photoshop Clipping Paths in PageMaker General Information 

If you have Photoshop 7, the Helpfile entitled "Placing Photoshop images in other applications" at ~/
Photoshop 7.0/Help/1_20_8_0.html will guide you. 

Note: If you do much of this kind of work, take a serious look at InDesign which imports transparent 
Photoshop files with no need for clipping paths. Soft effects are preserved and blend perfectly with InDesign 
objects. More details on InDesign at FAQ 4.7 - Consider InDesign 
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Topic 

3.7 - JPEG: Why you shouldn't use them in PageMaker

Donald Gruener - 09:20am May 3, 2002 Pacific

Issue: Why does everybody tell you not to use JPEGs in your PageMaker documents? 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 9:21am May 3, 02 PST (#1 of 1) Edited: 18-Jan-2005 at 03:26pm 

Here's a helpful illustration that John O over in the InDesign forum wrote: 

"JPGs are like VHS tape, and resaving is like making copies of copies. Open and save a JPG a few times, 
and soon your image looks bad. TIFs are more like CDs. Each resave is a perfect copy of the original. 

JPG was created to save space, and it does that job well. TIF was created for many things, among them 
desktop publishing, where reliability and image quality are more important than space." 

JPEGs are an image format used primarily on websites. They utilize a compression scheme that can render 
an image very acceptably on screen with very small file sizes, obviously important to the end user trying to 
view the web page. But what happens is that every time you re-save a JPEG, that compression scheme is 
being applied again, essentially throwing away more and more image data. 

When creating files for print, file size really needs to be secondary to quality. You can put a job on multiple 
CDs if necessary to get it to the service bureau or printer. Your primary concern should be the quality of your 
images, and the quality of your workflow. JPEG has no place in a quality PostScript workflow...only TIF and 
EPS. 

Perhaps a source of confusion is the use of JPEG for delivering stock photography. If you've ever purchased 
stock photography, you've probably noticed that you usually receive the images as JPEG. A large, high-
resolution file, saved one time as JPEG on the highest quality setting does not suffer any noticeable 
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degradation. The reduced file size facilitates downloading the image or getting a bunch of them onto a CD. 

But once you've acquired your stock image, you should never resave it as JPEG. Save it as .psd while you're 
working on it and save the finished image as a flattened TIF to place in PageMaker. The only JPEGs you 
should be saving are low-res images you're going to post on your website. 

Two myths about JPEGs 

"JPEGs lose quality every time they are opened and/or saved. 

False.
Simply opening or displaying a JPEG image does not harm the image in any way. Even opening an image 
and saving it again under a new name will not introduce further compression, unless additional editing was 
performed on the image. Saving a JPEG repeatedly during the same editing session (without ever closing 
the image) will not accumulate a loss in quality. 

JPEGs lose quality every time they are opened, edited and saved. 

True.
If a JPEG image is opened, edited, and saved again it results in additional image degradation. It is very 
important to minimize the number of editing sessions between the initial and final version of a JPEG image. If 
you must perform editing functions in several sessions or in several different programs, you should use a 
image format that is not lossy (TIFF, BMP, PNG) for the intermediate editing sessions before saving the final 
version. Repeated saving within the same editing session does not introduce additional damage. It is only 
when the image is closed, re-opened, edited and saved again." 

from: http://graphicssoft.about.com/library/weekly/aa0104jpegmyths.htm 

Do a search on Google if you're not convinced. Here's a sampling of what I found: 
http://www.soundray.de/jpgdemo/ 
http://www.faqs.org/faqs/jpeg-faq/part1/section-10.html 
http://www.theimage.com/web/graphic/jpgvsjpg/gif2A.html 
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3.8 - JPEG, GIF, WMF, BMP, etc - any problems

Donald Gruener - 09:00am Jan 23, 2002 Pacific

Issue: You are having ANY sort of problem with JPEGs, GIFs, WMFs, BMPs, CGMs, or any other placed 
graphic that is not a TIF or EPS. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

Donald Gruener - 9:07am Jan 23, 02 PST (#1 of 1) Edited: 18-Jan-2005 at 03:28pm 

The consensus is: Don't use any graphic in PageMaker that is not a TIF or EPS (you can place PDF, which 
PM handles like EPS). 

If you have a vector graphic that is not EPS, open it in Illustrator or CorelDraw and save it as EPS. 

If you have a raster image that is not TIF, open it with Photoshop or another image editing program and save 
it as TIF. 

And ALWAYS use File>Place to bring TIF and EPS into PageMaker. Do not copy/paste, do not drag/drop, do 
not use Insert Object. (When you have placed a TIF or EPS into a PageMaker document, it's perfectly fine 
however to copy/paste it to other locations within that document.) 

If you are having problems with the appearance of placed EPS or TIF graphics, follow these links: 

Your EPS looks & prints rough or "pixely" 

Your EPS has a white background 

Your TIF looks or prints blurry 

http://www.adobeforums.com/cgi-bin/webx?50@1020.pK5Zent919E.3@.ef645ec (1 of 2)13/09/2005 01:03:04

http://www.adobe.com/main.html
http://www.adobe.com/store/checkout/cart.jhtml
http://www.adobe.com/search/main.html
http://www.adobe.com/misc/comments.html
http://www.adobe.com/products/main.html
http://www.adobe.com/misc/solutions.html
http://www.adobe.com/support/main.html
http://www.adobe.com/store/main.jhtml
http://www.adobe.com/aboutadobe/main.html
http://www.adobe.com/support/forums/main.html
http://www.adobe.com/support/main.html
http://www.adobe.com/support/main.html
http://www.adobe.com/support/forums/main.html
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ee6b344
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef62cf6
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef62cf6
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?15@1020.pK5Zent919E.20@14@.ef645ec
http://www.adobeforums.com/cgi-bin/webx?18@1020.pK5Zent919E.20@14@.ef645ec
http://www.adobeforums.com/cgi-bin/webx?38@1020.pK5Zent919E.20@.ef645ec
http://www.adobeforums.com/cgi-bin/webx?bookmarks@1020.pK5Zent919E.20@
http://www.adobeforums.com/cgi-bin/webx?126@1020.pK5Zent919E.20@.ef645ec
http://www.adobe.com/support/main.html
http://www.adobeforums.com/Images/help/forumhelp.html
http://www.adobeforums.com/cgi-bin/webx?25@1020.pK5Zent919E.20@
http://www.adobeforums.com/cgi-bin/webx?15@@14@
http://www.adobeforums.com/cgi-bin/webx?224@1020.pK5Zent919E.20@ee729d5@.ef645ec
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?224@1020.pK5Zent919E.20@ee729d5@.ef645ec/0
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.20@.ef645ec/0
http://www.adobeforums.com/cgi-bin/webx?50@1020.pK5Zent919E.20@.ef6344c/0
http://www.adobeforums.com/cgi-bin/webx?50@1020.pK5Zent919E.20@.ef6344f/6
http://www.adobeforums.com/cgi-bin/webx?50@1020.pK5Zent919E.20@.ef6343f/0


Adobe Forums - 3.8 - JPEG, GIF, WMF, BMP, etc - any problems

Your CMYK TIF is dark & color-shifted in PageMaker 

Adobe Knowledgebase article about the limitations of metafiles 
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Donald Gruener - 01:12pm May 20, 2002 Pacific

thanks to Carl "viol8ion" Johnson 
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Donald Gruener - 1:13pm May 20, 02 PST (#1 of 1) Edited: 26-Feb-2003 at 09:12am PST 

First have the autocad file saved as a DXF. Then open that file using Illustrator or CorelDraw. 

Do a find & replace> replace objects> Replace Objects Pen Properties and increase the line width. You will 
have to experiment to find the thickness that works best for your docs. 

Save the file as EPS. 

You may also export the file as a TIF if the same images are used in other apps and printed locally to non-
PostScript printers. 

Use file>place to import the images into your PM docs. 

Thanks to Carl "viol8ion" Johnson 
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3.10 - Duotones & Multi-Channel Images

Donald Gruener - 01:06pm Nov 14, 2002 Pacific

Thanks to William E. Byers for his detailed and helpful contribution. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 
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Donald Gruener - 1:07pm Nov 14, 02 PST (#1 of 1) Edited: 18-Nov-2002 at 08:39am PST 

There seems to be some confusion about duotones and multi-channel images. Photoshop duotones aren't 
true multi-channel images, at least not the way Photoshop treats them (it's the same for monotone, tritone, 
and quadtone). If you create what looks like a duotone by eliminating 2 channels of a CMYK image, it's not 
the same thing, and it won't import into and print from PageMaker the way you expect. 

A Photoshop duotone must start out as a single-channel image (grayscale) - you can't choose "Duotone..." 
from the Image>Mode menu otherwise. Then you choose the colors you want to use; usually it's Black + a 
Pantone color, but it could just as easily be Black + Cyan or 2 different Pantone colors - whatever you 
choose. If you look at the Channels palette, you'll see "Duotone" listed and nothing else - Photoshop still 
treats the image as a single channel. You modify the appearance of the image by adjusting the curves for 
each color in the "Duotone..." dialog box. When you're ready to save, there will only be a few options for file 
type; Photoshop EPS is the one to use for importing into PageMaker - if you used a Pantone color, it will 
import the same as with any other EPS graphic. 

Settings for Saving Duotones 
These are the options I use when saving duotones: 
Photoshop EPS 
Preview: TIFF (8 bits per pixel) - this will give you a color preview in PageMaker; just remember that it 
probably won't be very accurate 
Encoding: ASCII (to ensure compatibility with any output device, although Binary also works for me) 
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(I leave all of the boxes unchecked.) 

Printing the duotone separations requires a little attention too. PageMaker always wants to print spot colors 
at 45°, with whatever line screen you're using, but if you print both of the separations with 45° screen angles, 
it'll be a disaster. I've often seen instructions to use the Black & Cyan or Black & Yellow angles from 
whatever optimized CMYK settings you're using, but here's what has always worked for me with duotones: 
Since moiré is minimized when the screens are at a 45° angle to each other, I just set them that way. 45° and 
0° would work - these are often the angles for Black & Yellow in optimized CMYK output - but if you have 
single-color screens in your document (screened boxes or headings, maybe), some of them would also be at 
0°, and that just looks funny. I usually choose 30° and 75°, and the results have always been fine. 

Multi-channel images are a different animal entirely, and I've only used them with PageMaker since spot 
color channels were introduced in Photoshop (version 5?). Here's a real-life example: a client has a drawing 
of something (like her truck) and wants 2-color business cards: the drawing in black, but "painted" PMS 186. 
Short of redrawing the truck as vector art, there was no reliable way of doing it before spot color channels in 
Photoshop: now you can scan the truck (grayscale), clean it up, and add a spot color channel in which to 
paint the red. This is the kind of multi-channel image (it's not a duotone, even though there are 2 colors in it) 
that needs to be saved as DCS format. 

Settings for Saving Multi-channel Images 
These are the options I use when saving multi-channel images: 
Photoshop DCS 2.0 
DCS: Multiple file with color composite (72 pixel per inch) 
Preview: TIFF (8 bits per pixel) 
Encoding: ASCII 
(I leave all of the boxes unchecked here too.) 

-William E. Byers 
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3.11 - Importing Adobe Illustrator Files (*.AI) and how they differ from *.EPS

John Davies - 07:42am Dec 7, 2003 Pacific

Why should I import a *.EPS file from Adobe Illustrator rather than a *.AI file? The *.AI file is smaller and 
looks better on the screen. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

John Davies - 7:46am Dec 7, 03 PST (#1 of 1) Edited: 07-Dec-2003 at 07:54am PST 

Here is an excerpt copied from comp.publish.prepress courtesy of LauraK, which was copied from the 
Illustrator Forum courtesy of Paul Asente. 

Following is the explanation of the differences posted in the Illustrator newsgroup by Paul Asente (the first 
name on the AI splash screen through AI10). 

What is the difference between an AI file and an EPS file? It has changed with time. In this message assume 
that when I write "EPS file" that I'm referring to an Illustrator-generated EPS. Other programs can write EPS 
files that are nothing at all like AI files. I'll also describe how PDF format fits in: 

Up through Illustrator 6: The content portion of an AI file and an EPS file are identical. The EPS file includes 
PostScript procedure definitions (called procsets) that allow the content part to be rendered by a PostScript 
printer. EPS files can optionally include a pre-rendered preview so that programs that can't interpret the 
PostScript code can display a low-resolution version of the image for reference. AI files leave out the 
procsets so that they can be smaller. 

Illustrator 7 and 8: No practical difference at all. AI files always contain the PostScript procsets. Disk space 
has become plentiful enough that the space saved by leaving out the procsets was no longer worth the 
hassle of making people worry about which format to save in. Only real difference is that EPS files can still 
contain previews. Illustrator can also write out PDF files, but they are not round-trippable: if you read the PDF 

http://www.adobeforums.com/cgi-bin/webx?50@1020.pK5Zent919E.3@.2ccec95b (1 of 2)13/09/2005 01:03:12

http://www.adobe.com/main.html
http://www.adobe.com/store/checkout/cart.jhtml
http://www.adobe.com/search/main.html
http://www.adobe.com/misc/comments.html
http://www.adobe.com/products/main.html
http://www.adobe.com/misc/solutions.html
http://www.adobe.com/support/main.html
http://www.adobe.com/store/main.jhtml
http://www.adobe.com/aboutadobe/main.html
http://www.adobe.com/support/forums/main.html
http://www.adobe.com/support/main.html
http://www.adobe.com/support/main.html
http://www.adobe.com/support/forums/main.html
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ee6b344
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ef62cf6
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ef62cf6
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?15@1020.pK5Zent919E.23@14@.2ccec95b
http://www.adobeforums.com/cgi-bin/webx?18@1020.pK5Zent919E.23@14@.2ccec95b
http://www.adobeforums.com/cgi-bin/webx?38@1020.pK5Zent919E.23@.2ccec95b
http://www.adobeforums.com/cgi-bin/webx?bookmarks@1020.pK5Zent919E.23@
http://www.adobeforums.com/cgi-bin/webx?126@1020.pK5Zent919E.23@.2ccec95b
http://www.adobe.com/support/main.html
http://www.adobeforums.com/Images/help/forumhelp.html
http://www.adobeforums.com/cgi-bin/webx?25@1020.pK5Zent919E.23@
http://www.adobeforums.com/cgi-bin/webx?15@@14@
http://www.adobeforums.com/cgi-bin/webx?224@1020.pK5Zent919E.23@ee6b3c2@.2ccec95b
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.ef8501c
http://www.adobeforums.com/cgi-bin/webx?224@1020.pK5Zent919E.23@ee6b3c2@.2ccec95b/0
http://www.adobeforums.com/cgi-bin/webx?14@1020.pK5Zent919E.23@.2ccec95b/0


Adobe Forums - 3.11 - Importing Adobe Illustrator Files (*.AI) and how they differ from *.EPS

file back into Illustrator, you lose document structure, although the results should look the same. 

Illustrator 9:EPS and AI completely different; AI is now based on PDF and Acrobat can open AI files. An EPS 
file contains two parts, one is a PostScript-renderable version of the illustration, and the other a compressed 
version of the old AI format. Illustrator ignores the PostScript portion when you read the file back in and only 
uses the AI portion; printing uses only the PostScript portion and ignores the AI portion. AI files contain a 
PDF rendition of the illustration instead of a PostScript version and also include the compressed AI format. 
Illustrator ignores the PDF content when you read the file back in; Acrobat ignores the AI portion. A PDF file 
is basically identical to an AI file but you have the option of leaving out the compressed AI section to make 
the file smaller for online distribution. 

Illustrator 10:Pretty much the same as Illustrator 9, but added the option when saving an AI file to omit the 
PDF rendition of the Illustration. It's still a PDF file, but if you open it in Acrobat all you see is a page with a 
canned message stating that the file was saved without PDF content. - Paul Asente 

For placing in PageMaker, placing a copy as Illustrator 8 *.EPS is the safest bet. 

- with thanks to Jay Chevako 
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3.12 - Picture Palette Error: "The image cannot be found. Please enter …"

John Davies - 03:28pm Apr 8, 2004 Pacific

When you try to drag an image from the Picture Palette in PM6.5 or PM7, you are met with the error 
message: "The image cannot be found. Please enter the new location of the image". 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 
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John Davies - 3:34pm Apr 8, 04 PST (#1 of 1) Edited: 18-Jan-2005 at 03:33pm 

SOLUTION 

Surf over to this page in the Adobe PM Support KB: 

●     Error "The image cannot be found..." When You Drag a Picture into a PageMaker Publication (7.x or 6.5 
Plus on Windows) 
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3.13 - What is the difference between RGB and CMYK?

John Davies - 03:27pm Jul 29, 2004 Pacific

Confusion between RGB and CMYK causes one of the most prevalent problems associated with image files. 
Even though results may look very similar on screen, RGB and CMYK colours are from two different colour 
space systems and are not interchangeable. 

| Back to Topic List 
To start a NEW discussion click on the Back to Topic List link and select Add Topic. 
If you are in an archive forum please go up to the main topic list (archives are read only). 

Messages 

1 message.   
 First    Previous      Next    Last  Show All Messages 

John Davies - 3:35pm Jul 29, 04 PST (#1 of 1) Edited: 29-Jul-2004 at 03:43pm PST 

RGB
Red, Green, Blue
The colour mode used in the Additive colour system on your monitor. In the Additive system, red, green and 
blue light are added together in various amounts to create all colours. Mixing equal amounts of red, green 
and blue light produce white, for example. 

RGB is the colour mode used by most desktop scanners. However, RGB colours will not image on a high-
end imagesetter as colour. 

RGB colour monitors, therefore, do not accurately represent the colour printed with ink on paper. If you use 
RGB in your electronic file, the colours you see on screen will image as CMYK, but the conversion 
will not always reflect the desired colour. 

CMYK
Cyan, Magenta, Yellow, Black
The colour mode used for printing on an off-set press, in four-colour process. The printing process, which 
prints with CMYK inks, uses subtractive colour. This system uses cyan, magenta, yellow and black filters to 
subtract light reflected from the sub-strata; subtracting all colour equals black. 
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If you want images to print as colour, they should be converted to CMYK in an image-editing program. 
Spot colours are to be used only if printing 2, 3 or 5 colours. 

If you want images to print as black and white, the images need to be changed to greyscale in the image-
editing program. 

- with acknowledgements to The Ovid Bell Press, Inc's "Electronic Prepress Guide" 
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